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ABSTRACT 

 

This project is a way to achieve this good cause. In this project, IoT based smart dustbin 

is built on a micro controller - based platform Node MCU board which is interfaced with 

three Proximity Sensor, Ultrasonic Sensor & IR Sensor, Battery and Servo Motor. 

Ultrasonic sensor is placed at the top of the dustbin which will measure the status of the 

dust limit. Once these smart bins are implemented on a large scale, by replacing our 

traditional bins present today, waste can be managed efficiently as it avoids unnecessary 

lumping of wastes on roadside. Foul smell from these rotten wastes that remain untreated 

for a long time, due to negligence of authorities and carelessness of public may lead to 

long term problems. Breeding of insects and mosquitoes can create nuisance around 

promoting unclean environment. This may even cause dreadful diseases.  
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CHAPTER 1 

INTRODUCTION 

 

1.1 Introduction 

One of a famous technology in this world is an Internet of Things (IOT). Network 

connecting objects is referred as IOT. The feature of this technology is to communicate 

and exchange the data among themselves. IOT are activate with the devices like sensor, 

motor and some UNO board [1]. Trash bin is used for storage the waste management in 

the world. In regular activities, a normal dustbin utilized for throwing the waste and 

dustbin is filled to empty the waste inside a dustbin. This is the basic use of a normal 

dustbin where no components are used, no coding is performed, and everything is done by 

hand manually. If the dustbin is full, people start throwing the waste around the dustbin, it 

causes smell and various diseases. To avoid this kind of problem, we used for IOT and 

some technology to keep the dustbin or garbage bin and environment very clean. A 

regular garbage bin is used to throw a waste [2]. 

A Smart dustbin is used to throw the waste, and to measure the level of the bin. Using 

electronic components such as Node MCU, Ultrasonic Sensor and IFTTT web hooks in a 

smart dustbin. Compare to normal dustbins, the smart dustbin is an effective one [3]. 

Smart dustbin is integrated with Node MCU, Ultrasonic sensor are a hardware 

component. In this project, Ultrasonic sensor is used to measure the distance and level of 

the dustbin and the Node MCU is used to upload the code and connecting with Wi-Fi. 

IFTTT webhook is a server to send the notification. The advantages of this technique are 

as follows: The above dustbin also send the mobile notification, when the dustbin is 

almost complete [4]. In this process, various electronic components are used to make this 

dustbin a smart dustbin. In this method, the disadvantages are as follows: the mobile 

should have a good notification signal from a carrier to receive notifications is very fast, if 

the mobile has not received a good signal, the notification will not be sanded [5]. 

We are living in an age where tasks and systems are fusing together with the power of 

IOT to have a more efficient system of working and to execute jobs quickly. With all the 

power at our finger tips this is what we have come up with. Building a general 

architecture for the IoT is hence a very complex task, mainly because of the extremely 
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large variety of devices, link layer technologies, and services that may be involved in 

such a system [6]. One of the main concerns with our environment has been solid waste 

management which impacts the health and environment of our society. The detection, 

monitoring and management of wastes is one of the primary problems of the present era. 

The traditional way of manually monitoring the wastes in waste bins is a cumbersome 

process and utilizes more human effort, time and cost which can easily be avoided with 

our present technologies. This is our solution, a method in which dustbin management is 

automated [7]. 

 

1.2 Objectives 

The main objective of this project is to develop the IoT Based Smart Dustbin system, 

which can sense the dust, categories it and store it different box. Our objectives are 

pointed out below: 

 To Design and Implementation of an Automatic Waste Segregation System. 

 To design and implement of Waste Monitoring & Notification system via 

internet. 

 To Design and implement automated system of dustbin monitoring. 

 To take necessary notes from the project for future improvements. 

 

1.3 Structure of the Project 

This project book consists of six chapters. The first chapter contains the statement of the 

introduction, our background study for the project, objectives of the study in the project 

and the project organization. Chapter two contains literature review, details discussion 

about home automation system. Chapter four deals with the design of this project, block 

diagram and circuit diagram, working principle. Chapter three describes the background 

and real project, details of component and instrument details of the whole project. The 

chapter five, we discuss about result and discussion and shows the complete prototype of 

the project that we have built. In the final and chapter six we discuss about future scope 

and conclusion of our project. 
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1 Introduction  
 

In this section topics related to Automatic Waste Segregation System are included. These 

provide a sampling of problems appropriate for application of waste segregate system. 

The references are summarized below.  

 

2.2 Literature Review 
 

In recent years, many issues and research on solid waste have been carried out, by 

developing a smart dustbin system and conducting socialization to the community. 

However, these studies must always be improved and carried out so that the waste issue in 

Indonesia can be reduced and become positive. What's even worse is the issue of plastic 

waste that continues to increase and flooding as a result of littering into rivers. As for 

some of these studies such as from studies [1] that developed smart dustbins for the 

university environment, but this research has not reported about the effects that occur 

after the implementation of smart dustbins, the improvement found is the need for special 

care for smart dustbins and recommendations for dustbins placed outside the room. 

Furthermore, [2] designed a mobile-based waste handling tool, using a proximity sensor 

and a weight sensor. In short, when the garbage is full, the system will automatically 

report the condition to the garbage officer. To be handled and also able to send 

information on the location of garbage, research has been carried out at several points in 

Makassar City, but the impact caused by this system has not been reported. Research by 

[3] which developed a smart dustbin to connect waste information with scavengers and 

authorities are using the Internet of Things (IoT) to create a clean and tidy city 

sustainably. 

Research by [4] developed a smart dustbin monitoring system using a wireless sensor 

network that has been tested in the village, but the impact has not been reported. Then 

from [5] the application of IoT-based smart dustbins that are placed in the corner of the 

outdoor street, infrared sensors are used to detect objects, make alarms sound and report 

the condition of the trash when it is full, and report that the smart dustbin is very useful 
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for the environment and for supporting the smart city system in the future. Also, [6] 

proposes the use of two smart dustbins that are effective for placing in public places in 

waste management in smart cities with a control system using GSM. Furthermore, [7] 

explained that in the future there will be a smart city, it must be supported by smart 

systems, such as smart dustbins. in India, especially for metro stations as tourist arrivals, 

strived to keep the environment clean, the importance of smart dustbins is recommended 

in waste management and helping to monitor the cleanliness of a smart city. Furthermore, 

[8] who proposed a prototype of a smart dustbin system for a smart city because it has 

very good motivation and effect in waste management in the modern era, especially in 

India. A recent study from [9] proposed designing a smart dustbin using a fuzzy logic 

algorithm based on Arduino, using two sensors, namely the Passive Infra-Red (PIR) 

sensor to detect objects and an ultrasonic sensor to detect the height of the trash. Fuzzy 

logic algorithms are used to determine indicator lights and alarms for garbage height 

information. However, the impact of the proposed system has not been reported, whether 

it can solve the waste problem in the environment that has been studied.  

The trash bin was proposed by [10], which accepted IoT then had 10 cm intensity. When 

garbage exceeds the threshold, the sensor activates the GSM modem, which warns the 

related authority before the bin is cleared. Various issues such as the affordability, the 

maintenance, and durability were addressed when these smart bins were planned, 

according to the conclusion.[11] They only used a weight-based sensors to reduce the 

value, and the sender only used Wi-Fi module to send and receive the data. The ultrasonic 

sensor detects the amount of garbage in the bin and communicates this information. The 

author suggested method for coordinating a garbage collection in residences of 

communities [13]. The amount of the waste in bins are sensed from ultrasonic sensor, that 

can send data to the area through a GSM. Graphical user interface (GUI) are created the 

access data from trash in different places; the GUI were supported by Simulation. So, it 

was special. Within the process, it was 2 type: slave unit used to be in a bin, and a master 

unit located in an office. Sensor is used to check the amount of a waste in the bin and 

transmit messages to a slave device, where it informs to administrators for clear trash. The 

article suggests network, that has been used to collect a waste inside location [14]. The 

device worked with unnecessary trash in the town is isolated places. System had two 

components. First was the collect some information who had been interested to a waste 
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collection or controlled automobiles as well as those who should arrange certain operators 

to transport garbage to different cities to town wastes.  

 

2.3 Smart Dustbin  

The smart dustbin is a carefully designed solution that solves the social issue of waste 

disposal, the smart dustbin identifies the kind of material being thrown inside it and 

segregates it into bio or non-biodegradable. The dustbin also comes with an option to 

provide Wi-Fi as an incentive of throwing garbage.  

 

Figure 2.1: Smart Dustbin 

Use of Smart Dustbin 

Smart Bins help to create a cleaner, safer, more hygienic environment and enhanced 

operational efficiency while reducing management costs, resources, and road-side 

emissions. The Smart Bin is ideal for busy locations such as campuses, theme parks, 

airports, railway stations, and shopping malls. 

2.4 Internet of Things (IoT) Basic Concept 

 
The intercommunication between device to device or machine learning connected through 

the internet with embedded technology systems using wireless sensors, actuators which is 
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remotely controlled, monitor and optimized by the user for automation is referred as 

Internet of things (IoT). Here the term “Things” means physical devices such as chips, 

cameras, sensors and other such devices. These physical devices are responsible to 

communicate, collect information and exchange data by connecting a network.  

The embedded technology of these physical devices makes this exchange of information 

each other possible. There are an assortment of home robotization includes that can help 

making life at home increasingly advantageous and simpler to oversee, particularly for 

occupied, huge families. Suppose you could consequently manage and control the gadgets 

that you ordinarily turn on and off each day. With a home computerization framework, 

you can manage appliances when you’re out of the house and wondering if you 

remembered to turn off light or not, smart system will be there to answer the question. 

The developing nearness of the Internet of Things in individual's lives has made 

development and advancement in the savvy home space, enabling clients to associate 

their gadgets through the web to their phones and tablets, and make better than ever 

benefits for family units.  

 

Figure 2.2: IoT Basic Concept (www.engineeringproject.com) 

In addition, as house owner are adjusting their gadgets to one focal application, gadget or 

center, they further understand the worth these home robotization items can bring to a 

family. It is the connectivity apart from the conventional devices using internet such as 

desktop, laptops, Smartphone, tablets etc. 

http://www.engineering/
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2.5 IoT Characteristics   

 
IoT is one of the most popular terms in this modern era of the world. Internet of things 

(IoT) explains the network of different devices like home appliances or office works that 

contains software, electronics, sensor and connectivity to allow them to exchange data 

with connections. Several sensors and actuators are used to connect those devices and 

give feedback to them according self-operations. IoT has convinced the world with its 

worldwide features and human beings are fully dependable on it. In the near future, this 

IoT will make an unimaginable impact on the daily life of human beings which will make 

the life of human easier, smarter and safe. At present, it has already grabbed the 

promising and large digital fields of modernization which is rapidly increasing. 

The characteristic of IoT includes the synthesis of hardware and software abiding by 

complex algorithm and computation technique which intelligence authorizes them to 

behave and act accordingly to the situations. The connectivity of IoT devices allows 

connecting various objects by creating network and comprehensive intelligence system. 

The dynamic nature of IoT devices tells the state of device whether it is on or off. An IoT 

device also collects dynamic change of data information from its neighboring 

environment. The essence of IoT is diversity and heterogeneity because of using distinct 

platform and network. Finally, security issues of IoT are being very important because of 

its delicate information and enormous action being taken to prevent security problems. In 

future IoT components enormity will increase in such level so that it becomes very 

difficult to deal or manage it. 

 

Figure 2.3: IoT Characteristics 
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2.6 Conclusion 

 In this chapter we have discuss about pervious literature summary.  

 That kind of project summary helps us to complete our project appropriately.  

 This kind of literature have some different method and different modification.  

 We get only our type of work and utilize on our project.  
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CHAPTER 3 

METHODOLOGY AND IMPLEMENTATION 

 

3.1 Introduction  

In this chapter we describe methodology, block diagram, circuit diagram, working 

procedure and its applications. In this chapter we gave some idea of automatic waste 

segregation system. 

 

3.2 Methodology 

Our methodologies for the project: 

 Creating an idea for Design and construction of “Automatic Waste Segregation 

System” And designing a block diagram & circuit diagram to know which 

components need to construct it.  

 Collecting the all components and circuit design to controlled the system. 

 Setting all components in a PCB board & soldering. Then assembling the whole 

block in a board and finally run the system & checking. 

 

3.3 Block Diagram of our proposed model 

 

In our project we have set up an Automatic Waste Segregation System, IR sensor will 

measure the object and two conductors are measure the dust type, proximity sensor will 

detect the iron metal and then micro controller store this dust a specific box. Here the 

current from the AC source is entering the DC output circuit with the help of an adapter. 

In this circuit we have used two micro controllers for controlling this system.  

 



 

 

10 

 

 

Figure 3.1: Block diagram of Automatic waste segregation system 

 

3.4 Circuit Diagram of proposed Model 

 

 

Figure 3.2: Circuit Design Automatic waste segregation system 
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3.5 Working Principle  

Here we propose an automatic smart dustbin that does all this by itself. There are two iron 

plates on this dustbin and in the middle of this iron plate there is an R sensor which will 

detect the object in the initial way. If you put dirt on this iron plate, it will be able to 

detect whether it is wet or dry. If the dirt is wet then the plate will be two shorts and 

current will flow through it. As a result, if the voltage is in Crete, the signal of micro 

controller will go. After that, according to the command of micro controller, with the help 

of servo motor, if it gets wet, it will throw dirt on one side and when it is dry, it will throw 

dirt on the other side. There are two ultrasonic sensors in the dustbin that will measure the 

dirt inside the box and show it on the display. On the top of this system there we install an 

proximity sensor. This sensor will detect the metal product. If anybody try to give some 

metal product the system will not be work in that situation. We use IoT App to develop 

the android Apps part for the IoT system. This bin is of a vast usage in offices, homes and 

even in public places for garbage management.  

 

3.6 Real View of Project Automatic waste segregation system 

 

 

Figure 3.3: Our Project Prototype  
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3.7 PCB Design: 

The PCB Layout module is automatically given connectivity information in the form of a 

net list from the schematic capture module. It applies this information, together with the 

user specified design rules and various design automation tools, to assist with error free 

board design. PCB's of up to 16 copper layers can be produced with design size limited by 

product configuration. 

 

 

 

Figure 3.4: PCB Design Automatic waste segregation system 

 

3.8 3D Verification: 

The 3D Viewer module allows the board under development to be viewed in 3D together 

with a semi-transparent height plane that represents the board’s enclosure. STEP output 

can then be used to transfer to mechanical CAD software such as Solid works or Autodesk 

for accurate mounting and positioning of the board. 
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Figure 3.5: 3D Verification (Solid Works) 

 

3.9 Conclusion 

 In this chapter we have discuss about automatic waste segregation system.  

 Waste segregation operation, working procedure and its application is the most 

effective waste collection method we want try to use in real life.  
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CHAPTER 4 

HARDWARE AND SOFTWARE DESCRIPTION 

 

4.1 Introduction  

 
In this chapter here brief description of our hardware and software. In this part we get a 

brief knowledge about our project structure. 

 
4.2 Equipment List 

 
This Project has worked on two things, Hardware and Software,   

 

Software   

 Proteus 8.9  

 Arduino IDE 

 Remote XY 

Hardware    

 Arduino Nano 

 Servo Motor  

 LCD Display 

 Ultrasonic Sensor 

 Node MCU 

 IR Sensor 
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4.3 Components Specification, Quantity and Cost 

 

Table 01: Component’s Name and Price 

Sl. No. Components Name Specification Quantity Unit 

Price(BDT) 

Total 

Price(BDT) 

01 Node MCU ESP 8266 1 550 550 

02 Arduino  Nano 1 480 480 

02 Servo Motor  3 350 1050 

03 LCD Display 16*2 1 380 380 

04 Ultrasonic Sensor  2 175 350 

05 IR Sensor 5V 1 100 100 

06 Proximity Sensor  1 520 520 

08 Others    1550 

Total 4980/= 

 

4.4 Arduino Nano 

Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software. It's intended for artists, designers, hobbyists, and anyone 

interested in creating interactive objects or environments. Arduino can sense the 

environment by receiving input from a variety of sensors and can affect its surroundings 

by controlling Lights, motors, and other actuators. 

 

Figure 4.1: Arduino Nano  
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The microcontroller on the board is programmed using the Arduino programming 

language (based on Wiring) and the Arduino development environment (based on 

Processing). Arduino projects can be stand-alone or they can communicate with software 

on running on a computer (e.g. Flash, Processing, Maxims’). Arduino Nano is a surface 

mount breadboard embedded version with integrated USB.  

It is a small, complete, and breadboard friendly component. It has everything that 

Decimal/ Duemilanove has (electrically) with more analog input pins and onboard +5V 

AREF jumper. Physically, it is missing power jack. The Nano can automatically sense 

and switch to the higher potential source of power. Nano’s got the breadboard-ability of 

the Boarding and the Minibus with smaller footprint than either, so users have more 

breadboard space. It’s got a pin layout that works well with the Mini or the Basic Stamp 

(TX, RX, ATN, and GND on one top, power and ground on the other). 

 

Figure 4.2: Arduino Nano Schematic Diagram 

This new version 3.0 comes with ATMEGA328 which offer more programming and data 

memory space. It has two layers. That make it easier to hack and more affordable. One of 

the best features of Arduino Nano is, it’s easy to use, compact and also small. 
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Figure 4.3: How Arduino Nano looks like 

Specifications:  

 Micro controller: Atmel ATmega328  

 Operating Voltage (logic level): 5 V  

 Input Voltage (recommended): 7-12 V  

 Input Voltage (limits): 6-20 V  

 Digital I/O Pins: 14 (of which 6 provide PWM output)  

 Analog Input Pins: 8  

 DC Current per I/O Pin: 40 mA  

 Flash Memory: 32 KB (of which 2KB used by boot loader)  

 SRAM : 2 KB  

 EEPROM: 1 KB  

 Clock Speed: 16 MHz  

 Dimensions: 0.70” x 1.70”  

Features:  

 Automatic reset during program download  

 Power OK blue LED  

 Green (TX), red (RX) and orange (L) LED  

 Auto sensing/switching power input  

 Small mini-B USB for programming and serial monitor  

 ICSP header for direct program download  

 Manual reset switch  
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Micro controller IC ATmega328p 

 

Figure 4.4: Micro controller IC AT mega 328p 

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro controller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 

2KB SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three 

flexible timer/counters with compare modes, internal and external interrupts, serial 

programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-

channel 10-bit A/D converter (8-channels in TQFP and QFN/MLF packages), 

programmable watchdog timer with internal oscillator, and five software selectable power 

saving modes. The device operates between 1.8-5.5 volts. By executing powerful 

instructions in a single clock cycle, the device achieves throughputs approaching 1 MIPS 

per MHz, balancing power consumption and processing speed.  

 

4.5 Node MCU 

Node MCU is an open source firmware for which open source prototyping board designs 

are available. The name "Node MCU" combines "node" and "MCU" (micro-controller 

unit). The term "Node MCU" strictly speaking refers to the firmware rather than the 

associated development kits. Both the firmware and prototyping board designs are open 

source. 

The firmware uses the Lua scripting language. The firmware is based on the eLua project, 

and built on the Espressif Non-OS SDK for ESP8266. It uses many open source projects, 
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such as lua-cjson and SPIFFS. Due to resource constraints, users need to select the 

modules relevant for their project and build a firmware tailored to their needs. Support for 

the 32-bit ESP32 has also been implemented. 

The prototyping hardware typically used is a circuit board functioning as a dual in-line 

package (DIP) which integrates a USB controller with a smaller surface-mounted board 

containing the MCU and antenna. The choice of the DIP format allows for easy 

prototyping on breadboards. The design was initially was based on the ESP-12 module of 

the ESP8266, which is a Wi-Fi SoC integrated with a Tensilica Xtensa LX106 core, 

widely used in IoT applications. 

 

Figure 4.5: Node MCU Pin Out 

Features:  

Wi-Fi Module – ESP-12E module similar to ESP-12 module but with 6 extra GPIOs. 

USB – micro USB port for power, programming and debugging Headers – 2x 2.54mm 

15-pin header with access to GPIOs, SPI, UART, ADC, and power pins Misc. – Reset and 

Flash buttons Power – 5V via micro USB port Dimensions – 49 x 24.5 x 13mm Node 

MCU was created shortly after the ESP8266 came out. On December 30, 2013, Espressif 

Systems began production of the ESP8266. The ESP8266 is a Wi-Fi SoC integrated with 

a Tensilica Xtensa LX106 core, widely used in IoT applications (see related projects). 

Node MCU started on 13 Oct 2014, when Hong committed the first file of NodeMCU-
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firmware to GitHub. Two months later, the project expanded to include an open-hardware 

platform when developer Huang R committed the gerber file of an ESP8266 board, 

named devkit v0.9. Later that month, Tuan PM ported MQTT client library from Contac 

to the ESP8266 SoC platform, and committed to Node MCU project, then Node MCU 

was able to support the MQTT IoT protocol, using Lua to access the MQTT broker. 

Another important update was made on 30 Jan 2015, when Devsaurus ported the u8glib to 

Node MCU project, enabling Node MCU to easily drive LCD, Screen, OLED, even VGA 

displays. In summer 2015 the creators abandoned the firmware project and a group of 

independent contributors took over.  

ESP8266 Arduino Core: 

As Arduino.cc began developing new MCU boards based on non-AVR processors like 

the ARM/SAM MCU and used in the Arduino Due, they needed to modify the Arduino 

IDE so that it would be relatively easy to change the IDE to support alternate toolchains 

to allow Arduino C/C++ to be compiled for these new processors. They did this with the 

introduction of the Board Manager and the SAM Core. A "core" is the collection of 

software components required by the Board Manager and the Arduino IDE to compile an 

Arduino C/C++ source file for the target MCU's machine language. Some ESP8266 

enthusiasts developed an Arduino core for the ESP8266 WiFi SoC, popularly called the 

"ESP8266 Core for the Arduino IDE". This has become a leading software development 

platform for the various ESP8266-based modules and development boards, including 

Node MCUs. 

 

Figure 4.6: Node MCU 
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4.6 5V Regulator IC 

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage 

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC, 

a member of 78xx series of fixed linear voltage regulators used to maintain such 

fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx 

indicates the output voltage it provides. 7805 IC provides +5 volts regulated power supply 

with provisions to add a heat sink.  

 

7805 IC Rating  

 Input voltage range 7V- 35V  

 Current rating Ic = 1A  

 Output voltage range VMax=5.2V , VMin=4.8V 

 

Figure 4.7: 5V Regulator IC 

The main mechanism of this regulator IC is regulated a fixed voltage of this project. This 

IC supply 5V 5Amp voltage/current for safety of this demo project. 

 

4.7 Servo Motor 

A servomotor is a closed-loop servomechanism that uses position feedback to control its 

motion and final position. The input to its control is a signal (either analogue or digital) 
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representing the position commanded for the output shaft. The motor is paired with some 

type of position encoder to provide position and speed feedback. In the simplest case, 

only the position is measured. The measured position of the output is compared to the 

command position, the external input to the controller. If the output position differs from 

that required, an error signal is generated which then causes the motor to rotate in either 

direction, as needed to bring the output shaft to the appropriate position. As the positions 

approach, the error signal reduces to zero and the motor stops. 

The very simplest servomotors use position-only sensing via a potentiometer and bang-

bang control of their motor; the motor always rotates at full speed (or is stopped). This 

type of servomotor is not widely used in industrial motion control, but it forms the basis 

of the simple and cheap servos used for radio-controlled models. More sophisticated 

servomotors use optical rotary encoders to measure the speed of the output shaft and a 

variable-speed drive to control the motor speed. Both of these enhancements, usually in 

combination with a PID control algorithm, allow the servomotor to be brought to its 

commanded position more quickly and more precisely, with less overshooting. 

 

Figure 4.8: Servo Motor 

4.8 LCD Display 

LCD (Liquid Crystal Display) screen is an electronic display module and find a wide 

range of applications. A 16x2 LCD display is very basic module and is very commonly 

used in various devices and circuits. These modules are preferred over seven segments 

and other multi segment LEDs. The reasons being LCDs are economical; easily 

programmable, have no limitation of displaying special & even custom characters (unlike 

in seven segments), animations and so on. A 16x2 LCD means it can display 16 
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characters per line and there are 2 such lines. In this LCD each character is displayed in 

5x7 pixel matrix. This LCD has two registers, namely, Command and Data. The 

command register stores the command instructions given to the LCD. A command is an 

instruction given to LCD to do a predefined task like initializing it, clearing its screen, 

setting the cursor position, controlling display etc. 

 

Features of LCD Display: 

5 x 8 dots with cursor 

Built-in controller (KS 0066 or Equivalent) + 5V power supply (Also available for + 3V) 

1/16 duty cycle B/L to be driven by pin 1, pin 2 or pin 15, pin 16 or A.K (LED) N.V. 

optional for + 3V power supply. 

 

Figure 4.9: 16*2 LCD Display 

 

4.9 IR Sensor:  

An infrared sensor is an electronics device that emits certain features around it and / or 

detects infrared radiation. Infrared sensors are capable of measuring the heat emitted by 

an object and detecting motion. In this project we will control the fan and light 

automatically through the closed loop system so the IR sensor for the system is definitely 
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needed as a response. Here the fan will turn on and the light will turn on when the IR 

sensor detects an object and the fan and light will switch off automatically when an object 

leaves the house. 

 

 

Figure 4.10 : IR Sensor 

 

Principles of operation: 

Sensor works with sense. When an object intersects the sensor light then the sensor 

detects something. Some infrared ray is deflected from the object and scene the length of 

this distance. In this sensor we can make a fixed length light and detect our exact object. 

If some object comes in front of this sensor, then the sensor detects it and sends a signal 

in LED. 

 

Figure 4.11:  IR sensor reflection System. 
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Figure 4.12:  IR sensor Detection System. 

 

4.10 Ultrasonic Sensor 

An ultrasonic sensor is an electronic device that measures the distance of a target 

object by emitting ultrasonic sound waves, and converts the reflected sound into an 

electrical signal. Ultrasonic waves travel faster than the speed of audible sound (i.e. 

the sound that humans can hear). Ultrasonic sensors have two main components: the 

transmitter (which emits the sound using piezoelectric crystals) and the receiver 

(which encounters the sound after it has travelled to and from the target). 

 

HC-SR04 Ultrasonic Sensor - Working 

As shown above the HC-SR04 Ultrasonic (US) sensor is a 4 pin module, whose pin 

names are Vcc, Trigger, Echo and Ground respectively. This sensor is a very popular 

sensor used in many applications where measuring distance or sensing objects are 

required. The module has two eyes like projects in the front which forms the 

Ultrasonic transmitter and Receiver. The sensor works with the simple high school 

formula that 

Distance = Speed × Time 

http://education.rec.ri.cmu.edu/content/electronics/boe/ir_sensor/images/409px-IR_Sensor_Principles.png
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The Ultrasonic transmitter transmits an ultrasonic wave, this wave travels in air and 

when it gets objected by any material it gets reflected back toward the sensor this 

reflected wave is observed by the Ultrasonic receiver module as shown in the picture 

below- 

 

 
Figure 4.13: Working of sensor 

 

Now, to calculate the distance using the above formulae, we should know the Speed 

and time. Since we are using the Ultrasonic wave, we know the universal speed of US 

wave at room conditions which is 330m/s. The circuitry inbuilt on the module will 

calculate the time taken for the US wave to come back and turns on the echo pin high 

for that same particular amount of time, this way we can also know the time taken. 

Now simply calculate the distance using a micro controller or microprocessor. 

 

How to use the HC-SR04 Ultrasonic Sensor 

HC-SR04 distance sensor is commonly used with both micro controller and 

microprocessor platforms like Arduino, ARM, PIC, Raspberry Pie etc. The following 

guide is universally since it has to be followed irrespective of the type of 

computational device used. Power the Sensor using a regulated +5V through the Vcc 

ad Ground pins of the sensor. The current consumed by the sensor is less than 15mA 

and hence can be directly powered by the on board 5V pins (If available). The Trigger 

and the Echo pins are both I/O pins and hence they can be connected to I/O pins of 

the micro controller. To start the measurement, the trigger pin has to be made high for 

10uS and then turned off. This action will trigger an ultrasonic wave at frequency of 



 

 

27 

 

40Hz from the transmitter and the receiver will wait for the wave to return. Once the 

wave is returned after it getting reflected by any object the Echo pin goes high for a 

particular amount of time which will be equal to the time taken for the wave to return 

back to the sensor. The amount of time during which the Echo pin stays high is 

measured by the MCU/MPU as it gives the information about the time taken for the 

wave to return back to the Sensor. Using this information, the distance is measured as 

explained in the above heading. 

 

Applications 

● Used to avoid and detect obstacles with robots like biped robot, obstacle 

avoider robot, path finding robot etc. 

● Used to measure the distance within a wide range of 2cm to 400cm 

● Can be used to map the objects surrounding the sensor by rotating it 

● Depth of certain places like wells, pits etc can be measured since the waves 

can penetrate through water 

Ultrasonic Sensor Pin Configuration 

 

Table 2: Ultrasonic Sensor Pin Configuration 

 

Pin 

Number 
Pin Name Description 

1 Vcc The Vcc pin powers the sensor, typically with +5V 

2 Trigger 

Trigger pin is an Input pin. This pin has to be kept 

high for 10us to initialize measurement by sending 

US wave. 

3 Echo 

Echo pin is an Output pin. This pin goes high for a 

period of time which will be equal to the time taken 

for the US wave to return back to the sensor. 

4 Ground This pin is connected to the Ground of the system. 
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HC-SR04 Sensor Features 

● Operating voltage: +5V 

● Theoretical Measuring Distance: 2cm to 450cm 

● Practical Measuring Distance: 2cm to 80cm 

● Accuracy: 3mm 

● Measuring angle covered: <15° 

● Operating Current: <15mA 

● Operating Frequency: 40Hz 

 

4.11 Proximity Sensor 

A proximity sensor is a sensor able to detect the presence of nearby objects without any 

physical contact.  

A proximity sensor often emits an electromagnetic field or a beam of electromagnetic 

radiation (infrared, for instance), and looks for changes in the field or return signal. The 

object being sensed is often referred to as the proximity sensor's target. Different 

proximity sensor targets demand different sensors. For example, a capacitive proximity 

sensor or photoelectric sensor might be suitable for a plastic target; an inductive 

proximity sensor always requires a metal target.  

Proximity sensors can have a high reliability and long functional life because of the 

absence of mechanical parts and lack of physical contact between the sensor and the 

sensed object.  

Proximity sensors are also used in machine vibration monitoring to measure the variation 

in distance between a shaft and its support bearing. This is common in large steam 

turbines, compressors, and motors that use sleeve-type bearings.  

Types of Proximity Sensor 

 Inductive Proximity Sensor. 

 Optical Proximity Sensor. 

 Capacitive Proximity Sensor. 

https://en.wikipedia.org/wiki/Sensor
https://en.wikipedia.org/wiki/Electromagnetic_field
https://en.wikipedia.org/wiki/Electromagnetic_radiation
https://en.wikipedia.org/wiki/Electromagnetic_radiation
https://en.wikipedia.org/wiki/Infrared
https://en.wikipedia.org/wiki/Electric_field
https://en.wikipedia.org/wiki/Signal
https://en.wikipedia.org/wiki/Capacitive_proximity_sensor
https://en.wikipedia.org/wiki/Capacitive_proximity_sensor
https://en.wikipedia.org/wiki/Photoelectric_sensor
https://en.wikipedia.org/wiki/Inductive_sensor
https://en.wikipedia.org/wiki/Inductive_sensor
https://en.wikipedia.org/wiki/Turbine
https://en.wikipedia.org/wiki/Gas_compressor
https://en.wikipedia.org/wiki/Bearing_(mechanical)
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 Magnetic Proximity Sensor. 

 Ultrasonic proximity Sensor. 

Proximity sensors are suitable for damp conditions and wide temperature range usage, 

unlike your traditional optical detection. Proximity sensors are also applicable in phones 

as well, be it your Andriod or IOS devices. It consists of simple IR technology that 

switches on and off display accordingly to your usage. Proximity sensors are used in 

phones, recycling plants, self-driving cars, anti-aircraft systems, and assembly lines. 

There are many types of proximity sensors, and they each sense targets in distinct ways. 

 

 Model: LJ12A3-4-Z/BY  

 Wire Type - Cylindrical DC 3 Wire Type 

 Switch Appearance Type - Cylinder Type  

 Theory - Inductive Sensor  

 Output Type - PNP NO(Normal Open) 

 Diameter of Head -  12mm  

 Detecting Distance  - 4mm  

 Supply Voltage -  DC 6-36V  

 Current Output - 300mA  

 Response Frequency  - 0.5KHz  

 Detect Object -  Iron  

 Operating Temperature -25°C to +55°C (Non-freezing Condition)  

 Size 6.2 x 2cm/2.4'' x 0.8'' (L*Max. Dia)  

 Cable Length 110cm/43.3"  

 External Material Plastic, Alloy  

 Net Weight 46g 
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Figure 4.14: Proximity Sensor  

 

4.12 Arduino Software  

The digital microcontroller unit named as Arduino Nano can be programmed with the 

Arduino software IDE. There is no any requirement for installing other software rather 

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to 

the microcontroller on our board). The IC used named as ATmega328 on the Arduino 

Nano comes pre burned with a boot loader that allows us to upload new code to it without 

the use of an external hardware programmer. 

Communication is using the original STK500 protocol (reference, C header files). We can 

also bypass the boot loader and programs the microcontroller through the ICSP (In Circuit 

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot 

loader, which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of 

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling 

the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode.The Arduino 

Nano is one of the latest digital microcontroller units and has a number of facilities for 

communicating with a computer, another Arduino, or other microcontrollers. The 

ATmega328 provides UART TTL at (5V) with serial communication, which is available 

on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data. An 

ATmega16U2 on the board channels this serial communication over USB and appears as 
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a virtual com port to software on the computer. The '16U2 firmware uses the standard 

USB COM drivers, and no external driver is needed. However, on Windows, an .in file is 

required. The Arduino software includes a serial monitor which allows simple textual data 

to be sent to and from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the 

USB-to-serial chip and USB connection to the computer (but not for serial 

Communication on pins 0 and 1). A Software Serial library allows for serial 

communication on any of the Nano's digital pins. The ATmega328 also supports I2C 

(TWI) and SPI communication. The Arduino software includes a Wire library to simplify 

use of the I2C bus. Arduino programs are written in C or C++ and the program code 

written for Arduino is called sketch. The Arduino IDE uses the GNU tool chain and AVR 

Lab to compile programs, and for uploading the programs it uses argued. As the Arduino 

platform uses Atmel microcontrollers, Atmel's development environment, AVR Studio or 

the newer Atmel Studio, may also be used to develop software for the Arduino. 

 

Figure 4.15: Arduino Software Interface IDE 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension .ino. The editor has features 
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for cutting/pasting and for searching/replacing text. The message area gives feedback 

while saving and exporting and also displays errors. The console displays text output by 

the Arduino Software (IDE), including complete error messages and other information. 

The bottom righthand corner of the window displays the configured board and serial port. 

The toolbar buttons allow you to verify and upload programs, create, open, and save 

sketches, and open the serial monitor. 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board 

and Tools > Port menus. The boards are described below. On the Mac, the serial port is 

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) 

or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, 

COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device 

in the ports section of the Windows Device Manager.  

On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the 

correct serial port and board, press the upload button in the toolbar or select the Upload 

item from the Sketch menu. Current Arduino boards will reset automatically and begin 

the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the 

reset button on the board just before starting the upload. On most boards, you'll see the 

RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will 

display a message when the upload is complete, or show an error. 

When you upload a sketch, you're using the Arduino boot loader, a small program that has 

been loaded on to the microcontroller on your board. It allows you to upload code without 

using any additional hardware. The boot loader is active for a few seconds when the board 

resets; then it starts whichever sketch was most recently uploaded to the microcontroller. 

The boot loader will blink the on-board (pin 13) LED when it starts (i.e. when the board 

resets). 
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Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and 

compile the library with your sketch. Because libraries are uploaded to the board with 

your sketch, they increase the amount of space it takes up. If a sketch no longer needs a 

library, simply delete its #include statements from the top of your code. 

There is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library 

Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a zip 

file and use it in an open sketch. See these instructions for installing a third-party library. 

Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your 

sketchbook directory. Platforms installed there may include board definitions (which 

appear in the board menu), core libraries, boot loaders, and programmer definitions. To 

install, create the hardware directory, then unzip the third-party platform into its own sub-

directory. (Don't use "arduino" as the sub-directory name or you'll override the built-in 

Arduino platform.) To uninstall, simply delete its directory. 

Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial 

connector. To send data to the board, enter text and click on the "send" button or press 

enter. Choose the baud rate from the drop-down menu that matches the rate passed to 

Serial.begin in your sketch. Note that on Windows, Mac or Linux the board will reset (it 

will rerun your sketch) when you connect with the serial monitor. Please note that the 

Serial Monitor does not process control characters; if your sketch needs a complete 

management of the serial communication with control characters, you can use an external 

terminal program and connect it to the COM port assigned to your Arduino board.You 

can also talk to the board from Processing, Flash, MaxMSP, etc (see the interfacing page 

for details). 
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4.13 Proteus Software 

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic 

design automation. The software is used mainly by electronics design engineers and 

technicians to create schematics and electronics prints for manufacturing printed circuit 

boards. The first version of what is now the Proteus Design Suite was called PC-B and 

was written by the company chairman, John Jameson, for DOS in 1988. Schematic 

Capture support followed in 1990 with a port to the Windows environment shortly 

thereafter. Mixed mode SPICE Simulation was first integrated into Proteus in 1996 and 

microcontroller simulation then arrived in Proteus in 1998. Shape based auto routing was 

added in 2002 and 2006 saw another major product update with 3D Board Visualization. 

More recently, a dedicated IDE for simulation was added in 2011 and MCAD 

import/export was included in 2015. Support for high speed design was added in 2017.  

 

Figure 4.16: Proteus Software Interface 

 

4.14 Remote XY: 

Remote XY is easy way to make and use a mobile graphical user interface for controller 

boards to control via smartphone or tablet. The system includes: 
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 Editor of mobile graphical interfaces for controller boards, located on the site 

remotexy.com 

 Mobile app Remote XY that allows to connect to the controller and control it 

via graphical interface.  

Distinctive features: 

 The interface structure is stored in the controller. When connected, there is no 

interaction with servers to download the interface. The interface structure is 

downloaded to the mobile application from the controller. 

 One mobile application can manage all your devices. The number of devices 

is not limited. 

Supported connection methods: 

 Internet over Cloud Server; 

 Wi-Fi client and access point; 

 Bluetooth; 

 Ethernet by IP or URL; 

 USB OTG (Android only that support USB OTG); 

Supported boards: 

 Arduino UNO, MEGA, Leonardo, Pro Mini, Nano, MICRO and compatible 

AVR boards; 

 ESP8266 boards; 

 ESP32 boards; 

 Chip KIT UNO32, Chip KIT uC32, Chip KIT Max32; 

Supported communication modules: 

 Bluetooth HC-05, HC-06 or compatible; 

 Bluetooth BLE HM-10 or compatible; 

 ESP8266 as modem; 

 Ethernet W5100; 

http://remotexy.com/ru/


 

 

36 

 

Supported IDE: 

 Arduino IDE; 

 FLProg IDE; 

 MPIDE; 

Supported mobile OS: 

 Android; 

 iOS; 

Remote XY is easy way to make a unique graphical interface to control micro controller 

device via mobile application, Arduino for example. 

Remote XY allows:  

 To develop any graphical management interface, using the control, display and 

decoration elements any combination thereof. You can develop the graphical 

interface for any task, placing the elements on the screen using the online editor.  

 After the development of the graphical interface, you get the source code for the 

micro controller that implements your interface. The source code provides a 

structure for interaction between your program with the controls and display. Thus 

you can easily integrate the control system into your task for which you are 

developing the device. 

 To manage micro controller device using your smartphone or tablet with the 

graphical interface. For manage used mobile application Remote XY. 

 Using one mobile application, you can manage a large number of devices with 

different graphical management interfaces. As the interface description is stored 

on board the micro controller device. 

The generated source code have a part that is starts with tag Remote XY include library 

and ends with tag END Remote XY include. This part of the code defines the structure 

of the graphical interface that you have created. In turn, this structure is also divided into 

parts. Consider the order. 
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4.15 Conclusion  

 In this chapter we have discuss about our project hardware and software which we 

use in our project.  
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CHAPTER 5 

EXPERIMENTAL OPERATIONS AND DISCUSSION 

 

5.1 Introduction  

In this chapter we will describe our project output result, its performance and discussion. 

Here we will find its accuracy.  

 

5.2 Operations 

After making our project we observe it very careful. It works as we desire. Our project 

give output perfectly and all equipment are work perfectly. We check how much it works 

and we get perfect output from this project. We have written our commands using the 

Arduino IDE and the following things can happen:  

 When the project is on. Then, it is able to operate automatically. 

 Firstly, when a person come in front of the dust bin it is open automatically. 

 When the system is powered on then ultrasonic sensor measure the dust level 

in the dust bin. 

 When dust is full it’s not open. Then, it is show a notification in user phone 

with android apps. 

 On the top of this system here we use a proximity sensor for detect metal. If 

anyone give a metal then this system detect and don’t open the door.  

 Dirt in the dustbin can cause gas inside. If gas is generated in it, it will detect 

gas and send notification to mobile apps through IOT. 

    

5.3 Advantages 

There are certainly many advantages of our project and some of the major ones have been 

given below: 

 Automatically Operated. 

 IoT Notification System. 

 Automatic metal detection process. 
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 Remotely garbage monitoring system. 

 Portable. 

 Cost Effective. 

 High Accuracy. 

 

5.4 Applications:  

Dustbin is very much used at the end of our daily work. So, it can be used everywhere. 

• It can be used in home. 

• It can be used in hospital. 

• It also can be used in shopping mall. 

• It can be used extensively on the side of the road to keep the city clean. 

 

5.5 Discussion 

While the thought comes up for Smart cities there is a prerequisite for Smart squander 

administration. The thought of Smart Dustbin is for the Keen buildings, Colleges, Healing 

centers and Transport stands. The Smart Dustbin in this way thought is an improvement 

of ordinary dustbin by elevating it to be keen utilizing sensors. Dustbins is an unused 

thought of implementation which makes a typical dustbin shrewd utilizing ultrasonic 

sensors for garbage level discovery and sending message to the client overhauling the 

status of the bin utilizing internet. The mobile apps screen is utilized to show the status of 

the level of rubbish collected in the bin. 
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CHAPTER 6 

CONCLUSION AND FUTURE SCOPE 

 

6.1 Conclusion: 

 We built an efficient garbage monitoring system which can be used to monitor the 

level of garbage in the dump.  

 Finlay has been able to do very well and the results are quite good.  

 We think that if it is used properly, the environment around us will be pollution 

free and we will have a clean environment. 

 

6.2  Future Scope: 

As we have already discussed about the limitations of our project so definitely there’s 

room for improvement and thus, we have lots of future scope of work available to us for 

this project. Some of these are listed below: 

 

 In future, we make it more efficient. 

 In future, we are thinking about adding more features to the system such as sensor 

and monitoring cameras. 

 In future we will add GSM Module for transfer dustbin information to city 

corporation by mobile text. 
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